HP ProBook 5220m Notebook PC

Maintenance and Service Guide

SUMMARY

This guide is a troubleshooting reference used for maintaining and servicing the computer. It provides
comprehensive information on identifying computer features, components, and spare parts;
troubleshooting computer problems; and performing computer disassembly procedures.
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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP ProBook 5220m Notebook PC

Processors Intel® Celeron®
e Intel Celeron U3400 1.06-GHz
Intel® Arrandale™
e Intel Arrandale i3-350M, 2.26-GHz, 3-MB L3 cache, 4 threads (35 W)
e Intel Arrandale i5-450M, 2.4-GHz (Turbo up to 2.66 GHz), 3-MB L3 Cache, 4
threads (35W)
e Intel Arrandale i5-520M, 2.4-GHz (Turbo up to 2.93 GHz), 3-MB L3 cache, 4
threads
e Intel Arrandale i5-540M, 2.53-GHz (Turbo up to 3.06 GHz), 3-MB L3 cache, 4
threads
Chipset Intel HM57 Express
Graphics Intel HD Graphics
Universal Memory Architecture (UMA) graphics subsystem integrated with shared
video memory (dynamically allocated)
Panels All display panel assemblies support privacy filter
LED backlight
e 30.734-cm (12.1-in) AntiGlare (1280x800)
e 30.734-cm (12.1-in) AntiGlare (1280x800) with webcam
e 30.734-cm (12.1-in) AntiGlare (1280x800) with webcam for use with WWAN
e  30.734-cm (12.1-in) BrightView (1280x800)
e  30.734-cm (12.1-in) BrightView (1280x800) with webcam
Memory 2 customer-accessible/upgradable SODIMM memory module slots

Supports dual-channel memory

Supports up to 8 GB of system memory

DDR3 PC3-10600 SDRAM (1333 MHz)
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Category

Description

Supports the following configurations:

e  8192-MB total system memory (4096-MB x 2, dual-channel)

e  4096-MB total system memory (4096-MB x 1)

e  4096-MB total system memory (2048-MB x 2, dual-channel)

e 3072-MB total system memory (2048-MB + 1024-MB, dual-channel)
e  2048-MB total system memory (2048-MB x 1)

e  2048-MB total system memory (1024-MB x 2, dual-channel)

e 1024-MB total system memory (1024-MB x 1)

Hard drives

Supports 9.5-mm, 6.35-cm (2.5-in) hard drives

Customer-accessible

Serial ATA (SATA)

Supports the following hard drives:

e  640-GB, 7200-rpm

e 500-GB, 7200-rpm

e  320-GB, 7200-rpm

e  250-GB, 7200-rpm

Supports the following solid-state drive:

e 80-GB

HP 3D DriveGuard (not available on Linux)

Audio/Visual

HD audio - IDT 92HD80

Integrated microphone

Two stereo speakers

Integrated 2.0-megapixel webcam (fixed focus)

Modem

High-speed 56k modem

Modem cable not included

Supports no-modem option

Ethernet

10/100/1000 Ethernet network interface card (NIC)

S3/S4/S5 wake on LAN (AC only mode)

Wireless

Integrated WLAN options by way of wireless module:

Support for the following WLAN formats:

e Intel Wi-Fi Link 1000 802.11b/g/n

e Intel WiFi Link 6200 802.11 a/b/g/n

e Broadcom 4322 802.11a/b/g/n Wi-Fi Adapter

e Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter

Chapter 1 Product description



Category

Description

2 WLAN antennas built into display assembly

Support for no-WLAN option

Integrated personal area network (PAN) options by way of Bluetooth® module:

Support for no-WPAN option

Broadcom Bluetooth 2.1 + Enhanced Data Rate (EDR)

Integrated WWAN options by way of WWAN module:

WWAN module Universal Notebook Data Platform (UNDP) with 2 antennas

Subscriber identity module (SIM) security (customer-accessible in battery bay)

External media cards

Media Card Reader supporting Memory Stick (MS), Memory Stick Pro (MSP),
Secure Digital (SD) Memory Card, Secure Digital High Capacity (SDHC) Memory
Card, MultiMediaCard (MMC), and xD-Picture Card formats

Ports

Audio-in/Audio-out (stereo microphone/headphone)

RJ-11 (modem)

RJ-45 (Ethernet, includes link and activity lights)

USB 2.0 (3)

Combo eSATA/USB 2.0 (1)

HDMI

VGA (Dsub 15-pin) supporting 1600%1200 external resolution at 75 GHz (hot plug/
unplug with auto-detect)

Multi-pin AC power

Keyboard and pointing devices

Keyboard with TouchPad

TouchPad with 2 TouchPad buttons and vertical scrolling (taps enabled as default)

Power requirements

65-W AC adapter with localized cable plug support (3-wire plug with ground pin)

4-cell, 41-Wh 2.8-Ah Li-ion battery

6-cell, 62-Wh 2.8-Ah Li-ion battery

Security

Supports Kensington security lock

Intel AT support

Integrated fingerprint reader
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Category

Description

Operating systems

Preinstalled:

Windows Vista® Home Basic (Japan only)
Windows Vista Business 32-bit (Japan only)
Windows® 7 Home Premium 32-bit (Japan only)
Windows 7 Home Premium 64-bit (Japan only)
Windows 7 Professional 32-bit (Japan only)
Windows 7 Professional 64-bit (Japan only)

Genuine Windows XP Professional available through downgrade rights from
Windows 7 (Japan only)

FreeDos
SuSE Linux (SLED11)

Red Flag Linux (People's Republic of China only)

Chapter 1 Product description



Category

Description

Microsoft Office preinstalled:

Windows Vista Home Basic 32-bit with Office Ready 2007 (excludes Japan)
Windows Vista Business 32-bit with Office Ready 2007 (excludes Japan)
Windows Vista Business 32-bit with Office Personal (Japan only)

Windows Vista Business 32-bit with Office Personal with PowerPoint (Japan
only)

Windows 7 Home Basic 32-bit with Office Ready 2007 (selected localizations
only)

Windows 7 Home Premium 32-bit with Office Ready 2007 (excludes Japan)
Windows 7 Home Premium 32-bit with Office Personal (Japan only)

Windows 7 Home Premium 32-bit with Office Personal with PowerPoint (Japan
only)

Windows 7 Home Pemium 64-bit with Office Ready 2007 (excludes Japan)
Windows 7 Home Premium 64-bit with Office Personal (Japan only)

Windows 7 Home Premium 64-bit with Office Personal with PowerPoint (Japan
only)

Windows 7 Professional 32-bit with Office Ready 2007 (excludes Japan)
Windows 7 Professional 32-bit with Office Personal (Japan only)

Windows 7 Professional 32-bit with Office Personal with PowerPoint (Japan
only)

Windows 7 Professional 64-bit with Office Ready 2007 (excludes Japan)
Windows 7 Professional 64-bit with Office Personal (Japan only)

Windows 7 Professional 64-bit with Office Personal with PowerPoint (Japan
only)

Genuine Windows XP Professional 32-bit available through downgrade rights
from Windows 7 Professional 32-bit with Office Ready 2007 (excludes Japan)

Genuine Windows XP Professional 32-bit available through downgrade rights
from Windows 7 Professional 32-bit with Office Personal (Japan only)

Genuine Windows XP Professional 32-bit available through downgrade rights
from Windows 7 Professional 32-bit with Office Personal with PowerPoint
(Japan only)
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Category

Description

Restore media:

Windows Vista Home Basic

Windows Vista Business 32-bit

Windows XP Professional

Windows 7 Home Basic 32-bit

Windows 7 Home Premium 32-bit

Windows 7 Home Premium 64-bit (not available with < 2 GB Memory)
Windows 7 Professional 32-bit

Windows 7 Professional 64-bit (not available with < 2 GB Memory)
Microsoft® Office Ready Restore

DRDVD Windows Vista

DRDVD Windows XP Professional

DRDVD Windows 7

Microsoft WHQL

SuSE Linux/Novell

Web-only support:

Windows Vista Enterprise 32-bit and 64-bit
Windows 7 Enterprise 32-bit and 64-bit

Windows 7 Ultimate 32-bit and 64-bit

Serviceability

End-user replaceable parts:

AC adapter
Battery (system)
Bluetooth module
Keyboard

Hard drive
Memory module
WLAN module

WWAN module

Chapter 1 Product description



2 External component identification

Identifying hardware

Components included with the computer may vary by region and model. The illustrations in this chapter
identify the standard features on most computer models.

Bf NOTE: Your computer may look slightly different from the illustrations in this section.

Identifying hardware 7
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Top components
TouchPad
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Component

Description

(1) TouchPad off indicator

To turn the TouchPad on and off, quickly double-tap the TouchPad
off indicator.

NOTE: When the TouchPad is on, the light is off.

(2) TouchPad

Moves the pointer and selects or activates items on the screen.

(3) Left TouchPad control

Functions like the left button on an external mouse.

(4) Right TouchPad control

Functions like the right button on an external mouse.

Chapter 2 External component identification



Lights

90006

Component

Description

()

TouchPad off indicator

Off: the TouchPad is on.

Amber: the TouchPad is off.

To switch between active and inactive, quickly double-tap the
TouchPad off indicator.

)

Caps lock light

On: Caps lock is on.

(3)

HP QuickLook light

On: QuickLook is on.

Off: QuickLook is off.

(4)

HP QuickWeb light

On: QuickWeb is on.

Off: QuickWeb is off.

(5) Power light e  On: The computer is on.
e  Blinking: The computer is in the Sleep state.
e  Off: The computer is off or in Hibernation.
(6) Wireless light e  White: An integrated wireless device, such as a wireless local

area network (WLAN) device, HP Mobile Broadband Module
(select models only), and/or a Bluetooth® device (select
models only), is on.

Amber: All wireless devices are off.

@)

Sound mute light

On: The speaker sound is muted.

Off: The speaker sound is not muted.

Top components
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Power button and fingerprint reader

O

>

Component

Description

(1) Power button

When the computer is off, press the button to turn on
the computer.

When the computer is on, press the button to shut
down the computer.

NOTE: Although you can shut down the computer
with the power button, the recommended procedure
is to use the Windows Shut Down command.

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

(2) Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

10 Chapter 2 External component identification



Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

NOTE: This feature does not exist if you are using the Linux

operating system.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.
NOTE: This feature does not exist if you are using the Linux
operating system.

(5) Embedded numeric keypad keys When the keypad has been enabled, it can be used like the keys
on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

Top components
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Front components

o o
€

Component

Description

(1) Drive light

e  White: The hard drive is being accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2) Speakers (2)

Produce sound.

(3) Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

12 Chapter 2 External component identification



Right-side components

000 o
D ©

o

®
0
I
©
®

Component Description

(1) Battery light °

Amber: A battery is charging.

White: A battery is close to full charge capacity.

Off: If the computer is plugged into an external power source,
the light turns off when the battery is fully charged. If the
computer is not plugged into an external power source, the
light stays off until the battery reaches a low battery level.

(2) Media Card Reader Supports the following optional digital card formats:

Memory Stick (MS)

Memory Stick Pro (MSP)

Memory Stick Duo (adapter required)
Memory Stick Duo Pro (adapter required)
MultiMediaCard (MMC)

MultiMediaCard Plus

Secure Digital (SD) Memory Card

SD High Capacity (HC) Memory Card
microSD Memory Card (adapter required)

xD-Picture Card (XD)

(3) Powered USB port Provides power to a USB device, such as an optional external
MultiBay or an optional external optical drive, if used with a powered
USB cable.

(4) USB port Connects optional USB devices.

Right-side components

13



Component

Description

(5) Audio-out (headphone)/Audio-in (microphone)
jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.
Also connects an optional headset microphone.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

WARNING! To reduce the risk of personal injury, adjust the
volume before putting on headphones, earbuds, or a headset. For
additional safety information, refer to the Regulatory, Safety, and
Environmental Notices.

(6) RJ-11 (modem) jack

Connects a modem cable.

(7) Power connector

Connects an AC adapter.

(8) Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

14 Chapter 2 External component identification



Left-side components

©

Component

Description

()

External monitor port

Connects an external VGA monitor or projector.

)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(©)

Network activity light

Amber: Data is being transmitted over the network.

(4)

RJ-45 (network) jack

Connects a network cable.

©)

Network connection light

Green: The computer is connected to the network.

(6) USB/eSATA port Connects a high-performance eSATA component, such as an
eSATA external hard drive, or connects an optional USB device.
(7) HDMI port Connects an optional video or audio device, such as a high-

definition television, or any compatible digital or audio component.

Left-side components
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Bottom components

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery and the subscriber identity module (SIM).

(3) Service access door release latches (2). Release the service access door.

(4) Vents (3) Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) Service access bay Provides access to the hard drive, 2 memory module slots, the

wireless local area network (WLAN) module, and the HP Mobile
Broadband Module (select models only; not supported by the Linux
operating system).

16 Chapter 2 External component identification



Display components

®

Component Description

(1) Internal display switch Turns off the display and initiates Sleep if the display is closed while
the power is on.

(2) Internal microphone Records sound.

(3) Webcam light (select models only)

On: The webcam is in use.

(4) Webcam (select models only)

Records audio and video and captures still photographs.

Display components

17



Wireless antennas

Your computer has at least two antennas that send and receive signals from one or more wireless
devices.

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with
wireless wide area networks (WWANSs).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with
wireless local area networks (WLANSs).

* For optimal transmission, keep the area immediately around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

18 Chapter 2 External component identification



Additional hardware components

Component Description

(1) Power cord* Connects an AC adapter to an AC outlet.

(2) AC adapter Converts AC power to DC power.

(3) Battery Powers the computer when the computer is not plugged into

external power.

*Power cords vary in appearance by country or region.

Additional hardware components 19



3 lllustrated parts catalog

Serial number label location

When you order parts or request information, the serial number label, located inside the battery bay,
provides important information that you may need when contacting technical support.

- 9
Serial: 0O IHININANEEIREERD

—Produc: XOOOCOOX MENNIENINENNIN
_Warranty: 1y 1y0y
rMﬂdd: X000

]

Component Description

(1) Part number The number that provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(2) Serial number An alphanumeric number that is unique to each
product.

(3) Product information The product name affixed to the front of your computer.

(4) Warranty period The duration of the warranty period for this computer.

(5) Model description The alphanumeric identifier you need to locate

documents, drivers, and support for your computer.
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Computer major components
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Item Description Spare part number

(1) 30.734-cm (12.1-in) Display assembly (includes 2 WLAN antennas and cables and, on select computer models, 2
WWAN antennas and cables)

NOTE: WWAN is available only on select models.

e  WXGA AntiGlare display assembly without webcam 610807-001
e  WXGA AntiGlare display assembly with webcam 610808-001
e  WXGA AntiGlare display assembly with webcam and WWAN 610809-001
e  WXGA BrightView display assembly without webcam 610810-001
e  WXGA BrightView display assembly with webcam 610811-001
(2) Switch cover 610832-001

3) Keyboard

e Forusein Japan 610826-291
e  For use in South Korea 610826-AD1
e Forusein Taiwan 610826-AB1
e  Foruse in Thailand 610826-281
e  Foruse in the United States 610826-001

(4) SIM (provided by your wireless vendor for use with WWAN option)

(5) Top cover

For use with models with fingerprint readers (includes TouchPad assembly) 610833-001

For use with models without fingerprint readers (includes TouchPad assembly) 610834-001
(6) RTC battery 599516-001
(7) Fan 610824-001
(8) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 610806-001. See Cable
Kit on page 27 for more Cable Kit spare part information.

High-speed 56K modem 510100-011

Cable Kit 610806-001

(9a) Bluetooth module cable

(9b) TouchPad cable

(9c) Power connector cable

(9d) RJ-11 (modem) cable

(9e) Hard drive connector cable

(10) Heat sink 610825-001
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Item Description Spare part number
(11) Bluetooth module 537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The

Bluetooth module cable is included in the Cable Kit, part number 610806-001. See Cable Kit

on page 27 for more Cable Kit spare part information.
(12) System board (includes processor and replacement thermal material)

e Includes Intel Celeron U3400 1.06-GHz processor 614536-001

° Includes Intel Arrandale 13-350M 2.26-GHz processor 610803-001

° Includes Intel Arrandale 15-450M 2.4-GHz processor 614534-001

e Includes Intel Arrandale 15-520M 2.4-GHz processor 614535-001

e Includes Intel Arrandale 15-540M 2.53-GHz processor 611373-001
(13) WWAN module, EVDO Birlion HSPA 531993-001
(14) WLAN module

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 593065-001

For use in Australia, Bangladesh, Bhutan, Brunei, Cambodia, East Timor, Fiji, Hong Kong,

India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands, Micronesia,

Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of

China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan,

Thailand, Tonga, Tuvalu, and Vietnam

Intel WiFi Link 6200 802.11a/b/g/n 572509-001

For use in Australia, Bangladesh, Bhutan, Brunei, Cambodia, East Timor, Fiji, Hong Kong,

India, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands, Micronesia, Nauru, Nepal,

New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of China, the

Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand,

Tonga, Tuvalu, and Vietnam

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001

For use in Australia, Bangladesh, Bhutan, Brunei, Cambodia, East Timor, Fiji, Hong Kong,

India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands, Micronesia,

Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of

China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan,

Thailand, Tonga, Tuvalu, and Vietnam

Broadcom 4322 802.11a/b/g/n 2x2 WiFi Adapter 518434-002

For use in Australia, Bangladesh, Bhutan, Brunei, Cambodia, Fiji, Hong Kong, India, Indonesia,

Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands, Micronesia, Nauru, Nepal, New

Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of China, the Philippines,

Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand, Tonga,

Tuvalu, and Vietnam
(15) Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared)

4096-MB 599092-001

2048-MB 581096-001

1024-MB 598859-001
(16) Audio board (includes cable) 610805-001
(17) Hard drive (includes hard drive bracket)

Computer major components
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Item Description Spare part number

SATA, 9.5-mm, 6.35-cm (2.5-in) hard drives

640-GB, 7200-rpm 610821-001
500-GB, 7200-rpm 610820-001
320-GB, 7200-rpm 610819-001
250-GB, 7200-rpm 610818-001

4.57-cm (1.8-in) solid-state drive

80-GB 610823-001

(18) Battery

4-cell, 41-Wh (2.8-Ah) Li-on 535630-001
6-cell, 62-Wh (2.8-Ah) Li-ion 596236-001
(19) Speakers 610831-001
(20) Base enclosure 610801-001

(21) Service access door

NOTE: The service access door is included in the Plastics Kit, spare part number
610828-001. See Plastics Kit on page 26 for more Plastics Kit spare part information.
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Display assembly components
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- P

Item Description Spare part number

(1) Display bezel

e  Fordisplays with webcam 610814-001

e  Fordisplays without webcam 610815-001
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Item  Description Spare part number
(2) Display panel
(3) Display cable (includes microphone and, on select models, webcam connector)
e  For displays with webcam 610816-001
e  For displays without webcam 614742-001
(4) Display Hinge Kit (includes left and right display hinges) 610817-001
(5) Webcam module 610835-001
(6) WWAN antennas and cables (included with display back cover used with WWAN
option)
(7) WLAN antennas and cables (included with display back cover)
(8) Display back cover
e  For displays without WWAN 610812-001
e  Fordisplays with WWAN 610813-001

Plastics Kit

Item

Description

Spare part number

Plastics Kit:

610828-001

Service access door
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Cable Kit

F

H

Item

Description

Spare part number

Cable Kit:

610806-001

()

Hard drive connector cable

()

Bluetooth cable

(3)

RJ-11 (modem) jack cable

(4)

Power cable

®)

TouchPad cable

Cable Kit
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Mass storage devices

07

Item  Description Spare part number

(1) Hard drive (includes bracket)

640-GB, 7200-rpm 610821-001

500-GB, 7200-rpm 610820-001

320-GB, 7200-rpm 610819-001

250-GB, 7200-rpm 610818-001
(2) Solid-state drive (includes bezel)

80-GB 610823-001
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Miscellaneous parts

Description

Spare part number

AC adapters

65-W, 3-pin Smart AC Adapter for use in all countries and regions except India 609939-001
65-W, 3-pin Smart AC Adapter for use only in India 609948-001
Power cords (AC power, 3-pin, black, 1.83-m)

e Foruse in Australia 490371-011
e Forusein India 490371-D61
e Forusein Japan 490371-291
e  Foruse in North America 490371-001
e  For use in the People's Republic of China 490371-AA1
e  Foruse in South Korea 490371-AD1
e Forusein Taiwan 490371-AB1
Rubber Kit (includes 4 base enclosure feet, display screw covers, and Bluetooth rubber cage) 610829-001
Screw kit—includes: 610830-001

Phillips M2.5x5.0
Phillips M2.0x3.0
Phillips M2.0x2.5

Phillips M3.0x3.5

Miscellaneous parts
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Sequential part number listing

Spare part
number

Description

490371-001

Power cord (AC power, 3-pin, black, 1.83-m), for use in North America

490371-011

Power cord (AC power, 3-pin, black, 1.83-m), for use in Austria

490371-291

Power cord (AC power, 3-pin, black,1.83-m), for use in Japan

490371-AA1

Power cord (AC power, 3-pin, black, 1.83-m), for use in the People's Republic of China

490371-AB1

Power cord (AC power, 3-pin, black, 1.83-m), for use in Taiwan

490371-AD1

Power cord (AC power, 3-pin, black,1.83-m), for use in South Korea

490371-D61

Power cord (AC power, 3-pin, black, 1.83-m), for use in India

510100-011

High-speed 56K modem

518434-002

Broadcom 4322 802.11a/b/g/n 2x2 WiFi Adapter

531993-001

WWAN module, EVDO Birlion HSPA

535630-001

Battery, 4-cell, 41-Wh (2.8-Ah) Li-ion

537921-001

Bluetooth module (without cable). The Bluetooth cable is included in the Cable Kit, spare part number
610806-001.

572509-001

Intel WiFi Link 6200 802.11a/b/g/n for use in Australia, Bangladesh, Bhutan, Brunei, Cambodia, East Timor,
Fiji, Hong Kong, India, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands, Micronesia, Nauru, Nepal,
New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of China, the Philippines, Samoa,
Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand, Tonga, Tuvalu, and Vietnam

581096-001

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 2048-MB

593065-001

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 for use in Australia, Bangladesh, Bhutan, Brunei, Cambodia,
East Timor, Fiji, Hong Kong, India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands,
Micronesia, Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of
China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand,
Tonga, Tuvalu, and Vietnam

593836-001

Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter for use in Australia, Bangladesh, Bhutan, Brunei, Cambodia,
East Timor, Fiji, Hong Kong, India, Indonesia, Japan, Kiribati, Laos, Malaysia, Maldives, Marshall Islands,
Micronesia, Nauru, Nepal, New Zealand, Pakistan, Palau, Papua New Guinea, the People's Republic of
China, the Philippines, Samoa, Singapore, Solomon Islands, South Korea, Sri Lanka, Taiwan, Thailand,
Tonga, Tuvalu, and Vietnam

596236-001

Battery, 6-cell, 62-Wh (2.8-Ah) Li-ion

598859-001

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 1024-MB

599092-001

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared), 4096-MB

599516-001

RTC battery

609939-001

65-W, 3-pin Smart AC adapter for use in all countries and regions except India

609948-001

65-W, 3-pin Smart AC adapter for use only in India

610801-001

Base enclosure

610803-001

System board (includes Intel Arrandale i3-350M 2.26-GHz processor and replacement thermal material)

610805-001

Audio board (includes cable)
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Spare part Description

number

610806-001 Cable Kit (See Cable Kit on page 27 for more Cable Kit spare part information.)
610807-001 Display assembly, WXGA AntiGlare without webcam

610808-001 Display assembly, WXGA AntiGlare with webcam

610809-001 Display assembly, WXGA AntiGlare with webcam and WWAN

610810-001 Display assembly, BrightView without webcam

610811-001 Display assembly, BrightView with webcam

610812-001 Display back cover for displays without WWAN

610813-001 Display back cover for displays with WWAN

610814-001 Display bezel for displays with webcam

610815-001 Display bezel for displays without webcam

610816-001 Display cable for displays with webcam (includes microphone and webcam connector)
610817-001 Display Hinge Kit (includes left and right display hinges)

610818-001 Hard drive, 250-GB, 7200-rpm (includes hard drive bracket)

610819-001 Hard drive, 320-GB, 7200-rpm (includes hard drive bracket)

610820-001 Hard drive, 500-GB, 7200-rpm (includes hard drive bracket)

610821-001 Hard drive, 640-GB, 7200-rpm (includes hard drive bracket)

610823-001 Solid-state drive, 4.57-cm (1.8-in), 80-GB (includes hard drive bracket)

610824-001 Fan

610825-001 Heat sink

610826-001 Keyboard for use in the United States

610826-281 Keyboard for use in Thailand

610826-291 Keyboard for use in Japan

610826-AB1 Keyboard for use in Taiwan

610826-AD1 Keyboard for use in South Korea

610828-001 Plastics Kit (includes service access door)

610829-001 Rubber Kit (includes 4 base enclosure feet, display screw covers, and Bluetooth rubber cage)
610830-001 Screw Kit (See Miscellaneous parts on page 29 for more Screw Kit spare part information.)
610831-001 Speaker assembly

610832-001 Switch cover

610833-001 Top cover, for use with models with fingerprint readers (includes TouchPad assembly)
610834-001 Top cover, for use with models without fingerprint readers (includes TouchPad assembly)
610835-001 Webcam module

611373-001 System board (includes Intel Arrandale i5-540M 2.53-GHz processor and replacement thermal material)
614534-001 System board (includes Intel Arrandale i5-450M 2.4-GHz processor and replacement thermal material)

Sequential part number listing
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Spare part Description

number

614535-001 System board (includes Intel Arrandale i5-520M 2.4-GHz processor and replacement thermal material)
614536-001 System board (includes Intel Celeron U3400 1.06-GHz processor and replacement thermal material)
614742-001 Display cable for displays without webcam (includes microphone)
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
° Flat-bladed screwdriver

° PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

Bf NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance

instructions.

Preliminary replacement requirements
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700 V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Preliminary replacement requirements
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.

Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.

36 Chapter 4 Removal and replacement procedures



Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +£10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This section provides removal and replacement procedures.

There are as many as 57 screws, in 5 different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

When you order parts or request information, provide the computer serial number and model number
provided on the service tag, located inside the battery bay.

O XHOOO000

]

Serial: J000CCCOC  IRIWIMANURNMANNN |

—Product: XOOO00X ENNIENIRRNEIN

_Warranty: 1y 1y0y
_ Madel: X000000(
Component Description
(1) Part number The number that provides specific information about the product's hardware

components. The part number helps a service technician to determine what
components and parts are needed.

)

Serial number

An alphanumeric number that is unique to each product.

(3)

Product information

The product name affixed to the front of your computer.

4

Warranty period

The duration of the warranty period for this computer.

(5

Model description

The alphanumeric identifier you need to locate documents, drivers, and support for
your computer.

38 Chapter 4 Removal and replacement procedures



Computer feet

Description Spare part number

Rubber Kit (includes computer feet) 610829-001

The computer feet are adhesive-backed rubber pads. There are 4 rubber feet that attach to the base
enclosure in the locations shown in the following illustration.

|
- | -
| | I
| |
| |
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Battery

Description Spare part number
4-cell, 41-Wh (2.8-Ah) Li-on battery 535630-001
6-cell, 62-Wh (2.8-Ah) Li-ion battery 596236-001

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1. Position the computer upside down on a flat surface with the battery bay toward you.

2. Slide the right lock latch (1) inward. The latch opening is marked red to indicate that the latch is
unlocked.

3. Slide the left release latch (2) inward and hold it in place as you slide and remove the battery (3).

To insert the battery:
1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery into the battery bay (1) until the battery release latch (2) clicks.
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3. Slide the battery lock (3) to the right to lock the battery into place.
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SIM
Bf NOTE: This section applies only to select models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the SIM:
1. Position the computer upside down with the battery bay toward you.
2. Press inon the SIM (1) to release it from the SIM slot.

3.  Remove the SIM (2) from the computer.

Install the SIM by inserting it into the SIM slot until you hear a click. To prevent damage to the connectors,
use minimal force when inserting a SIM.

/A CAUTION: IfaSIMisinserted backwards or upside down, the battery may not snap into place properly
and could damage the SIM and the SIM connector.

WLAN module

Description Spare part number

Intel Centrino Wireless-N 1000 802.11b/g/n 1x2 593065-001
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Description Spare part number

Intel WiFi Link 6200 802.11 a/b/g/n 572509-001
Broadcom 4313 802.11b/g/n 1x1 WiFi Adapter 593836-001
Broadcom 4322 802.11a/b/g/n 2x2 WiFi Adapter 518434-002

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the WLAN module:
1. Position the computer upside down with the battery bay toward you.

2. Slide the lock latch (1) on the service access door inward. The latch opening is marked red to
indicate that the latch is unlocked.

3. Slide the left release latch (2) inward and hold it in place as you slide the door toward the battery
bay.
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4. Release the latch and remove the service access door (3).

Bf NOTE: The service access door is available in the Plastics Kit, part number 610828-001.

5. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

B NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

6. Remove the PM2.0%3.0 screw (2) that secures the WLAN module to the system board. (The WLAN
module tilts up.)

7. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

Bf NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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WWAN module

Bf NOTE: Only select models include a WWAN module (see Product description on page 1).

Description Spare part number

EVDO Birlion HSPA 531993-001

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the service access door (see WLAN module on page 42).

Remove the WWAN module:
1. Position the computer upside down with the front toward you.

2. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

B NOTE: The red WWAN antenna cable is connected to the WLAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3.  Remove the PM2.0x3.0 screw (2) that secures the WWAN module to the system board. (The
WWAN module tilts up.)
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4. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

Bf NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Memory module

Description Spare part number

Memory module (DDR3 PC3-10600 SDRAM, 1333 MHz, shared)

1024-MB 598859-001
2048-MB 581096-001
4096-MB 599092-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the service access door (see WLAN module on page 42).

Remove the memory module:
1. Position the computer upside down with the front toward you.

2. Pullaway the retention clips (1) on each side of the memory module to release the memory module.
(The memory module tilts up.)

/A CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch
the components on the memory module.
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3.  Remove the memory module (2) by pulling the module away from the slot at an angle.

Bf NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion.

Reverse this procedure to install a memory module.

Hard drive

B NOTE: The hard drive spare part kit includes a hard drive connector and hard drive bracket.

Description Spare part number

SATA, 9.5-mm, 6.35-cm (2.5-in) hard drives:

250-GB 7200-rpm hard drive 610818-001
320-GB 7200-rpm hard drive 610819-001
500-GB 7200-rpm hard drive 610820-001
640-GB 7200-rpm hard drive 610821-001

4.57-cm (1.8-in) solid-state drive:

80-GB 610823-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 40).

5.  Remove the service access door (see WLAN module on page 42).

Remove the hard drive:
1. Position the computer upside down with the front toward you.
2. Disconnect the hard drive connector cable (1).

3.  Remove the two PM2.0x3.0 screws (2) and loosen the PM2.5%10.0 captive screw (3) that secures
the hard drive to the computer.

4. Grasp the Mylar tab (4) on the hard drive and lift the hard drive out of the hard drive bay.

5. Ifitis necessary to replace the hard drive bracket, follow these steps:
a. Remove the two PM3.0%3.5 hard drive bracket screws (1) from each side of the hard drive.

b. Lift the bracket (2) straight up to remove it from the hard drive.

S i

0
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Reverse this procedure to reassemble and install the hard drive.

50 Chapter 4 Removal and replacement procedures



Switch cover

Description Spare part number

Switch cover 610832-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

Remove the switch cover:

1. Position the computer upside down with the battery bay toward you.

2. Remove the three PM2.0x2.5 screws (1) inside the battery bay.

3. Remove the two PM2.5x6.5 screws (2) located outside the battery bay.

4. Position the computer right-side up with the front toward you, and open the computer.

5. Using a flat-bladed screwdriver, pry up the front edge of the switch cover from the keyboard.
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6. To prevent the tabs on the rear edge from breaking, lift the front edge (1) of the switch cover at an
angle, and then pull the switch cover (2) toward you to remove it from the computer.

Reverse this procedure to install the switch cover.
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Keyboard

Bf NOTE: The keyboard spare part kit includes a keyboard cable.

Description Spare part number
Keyboard

For use in Japan 610826-291

For use in South Korea 610826-AD1

For use in Taiwan 610826-AB1

For use in Thailand 610826-281

For use in United States 610826-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the switch cover (see Switch cover on page 51 ).

Remove the keyboard:
1. Position the computer right-side up with the front toward you.

2. Open the computer as far as possible.
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3.  Remove the two PM2.0x5.0 screws (1) that secure the keyboard to the computer.

4. Gently slide the keyboard back toward the display (1) until you hear the locking tabs release.

5. Lift the rear edge of the keyboard (2) and rotate it toward you until it rests at an angle.

54 Chapter 4 Removal and replacement procedures



6. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

7. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover

Description Spare part number
Top cover

NOTE: The top cover kit includes the TouchPad assembly.

For use with models with fingerprint readers 610833-001

For use with models without fingerprint readers 610834-001

Before removing the top cover, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. WLAN cables (see WLAN module on page 42)

d. WWAN cables (see WWAN module on page 45)

Remove the top cover:

1.

Position the computer upside down with the front toward you.
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2,

Remove the four PM2.5x5.0 screws along the front edge.
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Position the computer right-side up with the front toward you, and open the display as far as
possible.

Release and disconnect the following zero insertion force (ZIF) connector cables from the system
board:

a. Power cable (1)
b. TouchPad cable (2)
c. Fingerprint reader cable (3)

Remove the WLAN cables (4) from the routing channel.
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6. Remove the five PM2.5x5.0 screws that secure the keyboard to the base enclosure.

7. Lift the rear edge (1) of the top cover until it rests at an angle and you hear the locking tabs release.

8. Remove the top cover (2) by lifting first one side, then the other, until the top cover is released from
the enclosure.

Reverse this procedure to install the top cover.
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Display assembly

Description Spare part number

Display assembly (includes 2 WLAN antennas and cables and, on select computer models, 2 WWAN antennas and cables)

e  WXGA AntiGlare display assembly without webcam 610807-001
e  WXGA AntiGlare display assembly with webcam 610808-001
e  WXGA AntiGlare display assembly with webcam and WWAN 610809-001
e  WXGA BrightView display assembly without webcam 610810-001
e  WXGA BrightView display assembly with webcam 610811-001
Display bezel

e  For use with displays with webcam 610814-001
e  For use with displays without webcam 610815-001
Webcam module 610835-001
Display panel

Display Hinge Kit

e Display Hinge Kit (includes left and right display hinges) 610817-001

Display cable

e Display cable for use with displays with webcam (includes microphone and webcam connector) 610816-001

e Display cable for use with displays without webcam (includes microphone) 614742-001

WLAN antennas and cables (included with display back cover)

WWAN antennas and cables (included with display back cover used with WWAN option)

Display back cover

e  For use with displays without WWAN 610812-001

e  For use with displays with WWAN 610813-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)
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c. WWAN cables (see WWAN module on page 45)

d. WLAN cables (see WLAN module on page 42)

e. Top cover (see Top cover on page 56)

Remove the display assembly:

1. Disconnect the display cable (1) from the system board (2).

/A CAUTION: Support the display assembly when removing the following screws. Failure to support

the display assembly can result in damage to the display assembly and other computer
components.

2. Remove the four PM2.5%5.0 screws (1) that secure the display assembly to the base enclosure.

3. Lift the display assembly (2) straight up and remove it from the base enclosure.
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4. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the four
Mylar screw covers (1) and the four PM2.5%5.0 screws (2) that secure the display bezel to the
display assembly. The screw covers are available in the Rubber Kit, spare part number
610829-001.

5. Remove the bezel:

a. Flex the top (1) of the bezel from the inside edge until it disengages from the display back
cover.

b. Flexthe inside edge of the left side and the right side (2) of the bezel until it disengages from
the display back cover.

c. Flexthe bottom (3) of the bezel from the inside edge until it disengages from the display back
cover.

d. Remove the display bezel from the display back cover (4).

Bf NOTE: While removing the display bezel, gently remove the double-sided tape that attaches the
bezel to the display panel.
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6. Ifitis necessary to replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display back cover (1), disconnect the webcam cable from the module
(2), and then remove the webcam.

B NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

7. Ifitis necessary to replace the display hinges, remove the display panel by removing the two
PM2.5x5.0 screws and the two PM2.5%3.0 screws (1) that secure the panel to the display back
cover.

8. Remove the display panel (2).
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9. Remove the four PM2.0x3.0 screws (1) that secure the display hinges to the display panel, and
then remove the display hinges (2). The left and right display hinges are available in the Display
Hinge Kit, spare part number 610817-001.

10. Ifitis necessary to replace the display/webcam cable, turn the display panel upside down and peel
back the tape that secures the display cable to the display panel (1), and then release the connector
locking bar (2).

11. Release the cable from the display panel connector (3).

Ef NOTE: Thedisplay cable includes the microphone and, on select models, the webcam connector.

)"\____

Component replacement procedures

63



12. Gently pull the integrated microphone (1) from the clips at the top of the display back cover, remove
the display cable from the clips and routing channels (2) along the bottom of the display back cover,
and then remove the display cable (3).

13. If itis necessary to remove the wireless antennas and cables:

a. Detach the WLAN antennas and the WWAN antennas (1) from the adhesive on the back
cover, and then route the cables through the clips (2) that secure the antenna cables to the
display back cover.

b. Remove the wireless antennas and cables.

Reverse this procedure to reassemble and install the display assembly.
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Modem module

Description Spare part number

Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, 610806-001. See Cable Kit on page 27 for more Cable
Kit spare part information.

High-speed 56K modem 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 56)

Remove the modem module:
1. Position the computer right-side up with the front toward you.
2. Disconnect the modem module cable (1).

3.  Remove the two PM2.0x3.0 screws (2) that secure the modem module to the system board.
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4. Lift the modem module (3) straight up to disconnect it from the system board.

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Bluetooth module

Description Spare part number

Bluetooth module 537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 610806-001. See Cable Kit
on page 27) for more Cable Kit spare part information.

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 56)

Remove the Bluetooth module:
1. Position the computer right-side up with the front toward you.
2. Remove the Bluetooth module from the base enclosure (1).

3. Disconnect the Bluetooth module cable (2), and then remove the Bluetooth module.
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4. Remove the Bluetooth module cable (3) from the system board.

Reverse this procedure to install the Bluetooth module.

Audio board

Description Spare part number

Audio board (includes cable) 610805-001

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).
5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 56)

Remove the audio board:
1. Disconnect the audio board cable (1) from the system board.

2. Remove the PM 2.5x5.0 screw (2).
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3. Lift the audio board (3) straight up from the base enclosure.

o 2

Reverse this procedure to install the audio board.
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RTC battery

Description Spare part number

RTC battery 599516-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 56)

Remove the RTC battery:
1. Use a sharp, non-conductive tool to release the clip that secures the battery to the system board.

2. Lift the battery out of the computer.

To install the RTC battery, press it down into the socket until it is seated.
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System board

Bf NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

System board (includes replacement thermal material)

e Includes Intel Arrandale 13-350M 2.26-GHz processor 610803-001
e Includes Intel Arrandale 15-540M 2.53-GHz processor 611373-001
e Includes Intel Arrandale 15-450M 2.4-GHz processor 614534-001
e Includes Intel Arrandale 15-520M 2.4-GHz processor 614535-001
e Includes Intel Celeron U3400 1.06-GHz processor 614536-001

Before removing the system board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a. SIM (see SIM on page 42)

b. Switch cover (see Switch cover on page 51)

c. Keyboard (see Keyboard on page 53)

d. WWAN module (see WWAN module on page 45)

e. Bluetooth module and cable (see Bluetooth module on page 67)

f.  WLAN module (see WLAN module on page 42)

g. Hard drive (see Hard drive on page 48)

h. Top cover (see Top cover on page 56)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

Memory module (see Memory module on page 47)

WLAN module (see WLAN module on page 42)

WWAN module (see WWAN module on page 45)

Modem module (see Modem module on page 65)

SIM (see SIM on page 42)
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e Fan and heat sink (see Fan and heat sink on page 75)

e RTC battery (see RTC battery on page 70)

Remove the system board:
1. Position the computer upside down with the rear toward you.

2. Disconnect the power connector cable from the system board.

Position the computer right-side up with the front toward you.
Disconnect the speaker cable (1) from the system board.

Disconnect the Bluetooth cable (2) from the system board.

o g » »

Disconnect the audio board cable (3) from the system board.
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10.

Disconnect the display panel cable (1) from the system board.

Disconnect the power button ZIF cable (2) from the system board.

Remove the two PM2.5%5.0 screws that secure the system board to the base enclosure.

Lift the right side of the system board from the base enclosure (1).
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11. Lift the system board up and to the right to remove the system board (2).

Reverse this procedure to install the system board.
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Fan and heat sink

Bf NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
Fan 610824-001
Heat sink 610825-001

Before removing the heat sink, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a.

b.

SIM (see SIM on page 42)

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

WWAN module (see WWAN module on page 45)

Bluetooth module (see Bluetooth module on page 67)

WLAN module (see WLAN module on page 42)

Hard drive (see Hard drive on page 48)

Top cover (see Top cover on page 56)

System board (see System board on page 71)

Remove the heat sink:

1.
2.

Position the system board upside down on a flat surface.

Disconnect the fan cable from the system board (1).
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3. Loosen the two PM2.0%5.0 captive screws (2) from the system board, and then remove the fan

(3).

4. Following the sequence stamped into the heat sink, loosen the four PM2.5x10.0 captive screws
(1) that secure the heat sink to the processor.

5.  Lift the heat sink off the processor (2).

Ef NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink
components (1) and (2), and the system board components (3) and (4), each time the heat sink is
removed. Replacement thermal material is included with all heat sink and system board spare part
kits.
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Reverse this procedure to install the heat sink and fan.
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Speakers

Description Spare part number

Speakers

610831-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 40).

5. Remove the following components:

a.
b.
c.

d.

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Top cover (see Top cover on page 56)

System board (see System board on page 71)

Remove the speakers:

1. Position the computer right-side up with the front toward you.

2. Remove the two PM2.0%3.0 screws (1) that secure the speakers to the base enclosure.

3.  Remove the speakers from the computer (2).

Reverse this procedure to install the speakers.
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Security cable slot bracket

Before removing the security cable slot bracket, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a. Switch cover (see Switch cover on page 51)

b. Keyboard (see Keyboard on page 53)

c. Top cover (see Top cover on page 56)

d. System board (see System board on page 71)

Remove the security cable slot bracket:

1.
2.

4,

Position the computer right-side up with the right side toward you.

Remove the two PM2.0x5.0 screws (1) that secure the security cable slot bracket to the base
enclosure.

Lift the bracket (2) from the rear at an angle up and out.

(1
I
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Disconnect the bracket from the power connector.

Reverse this procedure to install the security cable slot bracket.
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Power connector cable

B NOTE: The power connector cable is included in the Cable Kit on page 27, part number 610806-001.

Before removing the power connector cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a.
b.
c.
d.

e.

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Top cover (see Top cover on page 56)

System board (see System board on page 71)

Security cable slot bracket (see Security cable slot bracket on page 79)

Remove the power connector cable.

1.
2,
3.

Position the computer right-side up with the front toward you.

Remove the power connector cable (1) from the routing in the base enclosure.

Remove the power connector cable from the base enclosure (2).

Reverse this procedure to install the power connector cable.
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Modem module cable

Bf NOTE: The modem module cable with RJ-11 connector is included in the Cable Kit on page 27, part
number 610806-001.

Before removing the modem module cable, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 40).

Remove the following components:

a.

b.

g.
h.

Switch cover (see Switch cover on page 51)

Keyboard (see Keyboard on page 53)

Speakers (see Speakers on page 78)

Hard drive (see Hard drive on page 48)

Display assembly (see Display assembly on page 59)

Top cover (see Top cover on page 56)

System board (see System board on page 71)

Security cable slotbracket (see Security cable slot bracket on page 79)

Remove the modem cable.

1.
2,

Position the computer right-side up with the front toward you.

Release the modem RJ-11 connector from the base enclosure clips (1).
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3. Remove the modem cable (2) from the routing in the base enclosure.

Reverse this procedure to install the modem cable.
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5 Computer Setup

Computer Setup in Windows 7

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

Computer Setup in Windows 7 83



B NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

149,

¥ NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.
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To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

B NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.
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B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu
Select To do this
System Information e View identification information for the computer and the
batteries in the system.

e View specification information for the processor, memory
size, system ROM, video revision, keyboard controller
version, and wireless identification numbers.

Set System Date and Time Set or change the date and time on the computer.
System Diagnostic Display the following information:

e  System Information
° Identification information for the computer and the

batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Start-up Test: verifies the system components needed for
starting the computer.

e  Run-In Test: runs a comprehensive check on system
memory.

e Hard Disk Test: runs a comprehensive self-test on any
hard drive in the system.

e  Memory Test: runs a comprehensive test on any memory
installed in the computer.

e  Battery Test: runs a comprehensive test on any batteries
installed in the computer.

e  Error Log: displays a log file if any errors have occurred.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Resets password to the factory default in case of a forgotten
password.

Ignore Changes and Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.
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Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)

e Create a new BIOS user account.

e View a list of HP ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enroliment (enabled by default).

Anti Theft (select models only)

Enable/disable anti-theft protection.

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (disabled by
default).

Allow reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enroliment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DrivelLock user password or master password.
NOTE: DrivelLock settings are accessible only when you

enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive.

CAUTION: Ifyourun Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.
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Select To do this

Boot Options e  Seta Startup Menu delay (in seconds).
e  Set the MultiBoot Express Boot Popup delay in seconds.
e Enable/disable Custom Logo (disabled by default).

e Enable/disable Display Diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e Enable/disable SD Card boot (enabled by default).
e Enable/disable floppy boot (enabled by default).

e Enable/disable PXE Internal NIC boot (enabled by
default).

e Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

e  Set the Express Boot Popup delay in seconds.

e  Set the boot order.

Device Configurations e Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

0 Startup from bootable USB devices, including a hard
drive, diskette drive, or external optical drive
connected by a USB port to the computer.

e  Enable/disable fan always on while connected to an AC
outlet (enabled by default).

° Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

e Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN when
not in use (enabled by default).

e  SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

0 AHCI (Advanced Host Controller Interface)

° IDE (Integrated Drive Electronics)
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Select To do this

NOTE: Auvailability of the options above varies by
computer model.

e Enable/disable HP DayStarter (enabled by default).
e Enable/disable HP QuickLook (enabled by default).

e Enable/disable Preboot Authentication on HP QuickLook
Boot (disabled by default).

e Enable/disable Virtualization Technology (select models
only; disabled by default).

e Enable/disable HP QuickWeb (enabled by default).

e Enable/disable HP QuickWeb write protect (disabled by
default).

e Enable/disable Multi Core CPU (enabled by default).

e  Enable/disable Intel® HT Technology (enabled by
default).

e Enable/disable wake on USB (enabled by default).

° Enable/disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

° Turn the Numlock state at boot on or off.
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Select

To do this

Built-In Device Options

e Enable/disable the wireless button state (enabled by
default).

e Enable/disable the embedded WLAN device (enabled by
default).

e Enable/disable embedded WWAN device radio (select
models only; enabled by default).

e Enable/disable embedded Bluetooth® device radio
(enabled by default).

e  Enable/disable the Network Interface Controller (LAN)
(enabled by default).

e  Enable/disable LAN/WLAN switching (disabled by
default).

e  Setthe wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
o Follow Boot Order

e Enable/disable the fingerprint device (enabled by
default).

e Enable/disable a modem device (enabled by default).

e Enable the ambient light sensor (enabled by default).

e Enable/disable the Notebook MultiBay device (enabled by

default).

e  Enable/disable the integrated camera (select models only;
enabled by default).

e Enable/disable the power monitor circuit (enabled by
default).

e Enable/disable the audio device (enabled by default).
e Enable/disable optical disc drive (enabled by default).
e Enable/disable internal microphone (enabled by default).

e Enable/disable the internal speakers (enabled by default).

Port Options (all are enabled by default)

NOTE: All port options are enabled by default.
e Enable/disable the Smart Card slot.

e Enable/disable the flash media reader.

e  Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices on the advanced port replicator.

e  Enable/disable the 1394 port.

e  Enable/disable the eSATA port.

Computer Setup in Windows 7
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Select To do this

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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Computer Setup in Windows Vista and Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

B NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e Tosave your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

Ef NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turnon or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.
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To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your

computer.
File menu
Select To do this
System Information e View identification information for the computer and the
batteries in the system.

e View specification information for the processor, memory
size, system ROM, video revision, keyboard controller
version, and wireless identification numbers.

Set System Date and Time Set or change the date and time on the computer.
System Diagnostic Display the following information:

e  System Information
° Identification information for the computer and the

batteries in the system.

o Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Start-up Test: verifies the system components needed for
starting the computer.

e  Run-In Test: runs a comprehensive check on system
memory.

e Hard Disk Test: runs a comprehensive self-test on any
hard drive in the system.

° Memory Test: runs a comprehensive test on any memory
installed in the computer.

e  Battery Test: runs a comprehensive test on any batteries
installed in the computer.

e  Error Log: displays a log file if any errors have occurred.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security settings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Resets password to the factory default in case of a forgotten
password.

Ignore Changes and Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)

e Create a new BIOS user account.

e View a list of HP ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enroliment

Enable/disable HP SpareKey enrollment (enabled by default).

Anti Theft (select models only)

Enable/disable anti-theft protection.

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (disabled by
default).

Allow reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e Enable/disable DriveLock on any computer hard drive
(enabled by default).

e  Change a DrivelLock user password or master password.
NOTE: DrivelLock settings are accessible only when you

enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock

Enable/disable Automatic DriveLock support.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive.

CAUTION: Ifyourun Disk Sanitizer, the data on the selected
drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.

System Configuration menu

B NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.
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Select To do this

Boot Options e  Seta Startup Menu delay (in seconds).
e  Set the MultiBoot Express Boot Popup delay in seconds.
e Enable/disable Custom Logo (disabled by default).

e Enable/disable Display Diagnostic URL (enabled by
default).

e Enable/disable CD-ROM boot (enabled by default).
e Enable/disable SD Card boot (enabled by default).
e Enable/disable floppy boot (enabled by default).

e Enable/disable PXE Internal NIC boot (enabled by
default).

e Enable/disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

e  Set the Express Boot Popup delay in seconds.

e  Set the boot order.

Device Configurations e Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not running.

° Startup from bootable USB devices, including a hard
drive, diskette drive, or external optical drive
connected by a USB port to the computer.

e Enable/disable fan always on while connected to an AC
outlet (enabled by default).

° Enable/disable Data Execution Prevention. When
enabled, the processor can disable some virus code
execution, which helps to improve computer security.

e  Enable/disable LAN Power Save (select models only).
When enabled, saves power by turning off the LAN when
not in use (enabled by default).

e  SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

o AHCI (Advanced Host Controller Interface)

o IDE (Integrated Drive Electronics)
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Select To do this

NOTE: Availability of the options above varies by
computer model.

e Enable/disable HP DayStarter (enabled by default).
e Enable/disable HP QuickLook (enabled by default).

e Enable/disable Preboot Authentication on HP QuickLook
Boot (disabled by default).

e Enable/disable Virtualization Technology (select models
only; disabled by default).

e Enable/disable HP QuickWeb (enabled by default).

e Enable/disable HP QuickWeb write protect (disabled by
default).

e Enable/disable Multi Core CPU (enabled by default).

e Enable/disable Intel® HT Technology (enabled by
default).

e Enable/disable wake on USB (enabled by default).

° Enable/disable Unified Extensible Firmware Interface
(UEFI) mode (disabled by default).

e  Turn the Numlock state at boot on or off.

96 Chapter 5 Computer Setup



Select

To do this

Built-In Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable the embedded WLAN device (enabled by
default).

Enable/disable embedded WWAN device radio (select
models only; enabled by default).

Enable/disable embedded Bluetooth® device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
o Follow Boot Order

Enable/disable the fingerprint device (enabled by
default).

Enable/disable a modem device (enabled by default).
Enable the ambient light sensor (enabled by default).

Enable/disable the Notebook MultiBay device (enabled
by default).

Enable/disable the integrated camera (select models
only; enabled by default).

Enable/disable the power monitor circuit (enabled by
default).

Enable/disable the audio device (enabled by default).
Enable/disable optical disc drive (enabled by default)..
Enable/disable internal microphone (enabled by default).

Enable/disable the internal speakers (enabled by default).

Port Options (all are enabled by default)

NOTE: All port options are enabled by default.

Enable/disable the Smart Card slot.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices on the advanced port replicator.

Enable/disable the 1394 port.

Enable/disable the eSATA port.

Computer Setup in Windows Vista and Windows XP
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Select To do this

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

98 Chapter 5 Computer Setup



Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is displayed
in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not operating system based, it does not support the TouchPad.
Navigation and selection are by keystroke:

To choose a menu or a menu item, use the arrow keys.

To select an item, press enter.

To close open dialog boxes and return to the main Computer Setup screen, press esc.
To view navigation information, press f1.

To change the language, press 2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

To exit Computer Setup without saving your preferences, use the arrow keys to select
File > Ignore Changes And Exit. Then follow the instructions on the screen.

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing 10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

File menu

Ef NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

Ef NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.

Select To do this

Setup Password Enter, change, or delete a setup password.
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Select To do this

Password Options e Enable/disable stringent security.

e Enable/disable the password requirement on computer
restart.

DriveLock Passwords e Enable/disable DriveLock on any computer hard drive.

e Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e  Fast: Runs the Disk Sanitizer erase cycle once.
e  Optimum: Runs the Disk Sanitizer erase cycle 3 times.

e  Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary
hard drive is destroyed permanently.

Diagnostics menu

B NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.
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System Configuration menu

Bf NOTE: Some of the menu items listed in this section may not be supported by your computer or your
operating system.

Select To do this
Language Change the Computer Setup language.
Boot options e Setanf9, 10, and f12 delay when starting up.

e Enable/disable CD-ROM boot.
e Enable/disable floppy boot.
e Enable/disable internal network adapter boot.

e Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

e  Set the Express Boot Popup delay in seconds.
e  Set the boot order.

o 1st boot device: USB CD-ROM

° 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

o 4th boot device: Notebook hard drive

o 5th boot device: USB hard disk

° 6th boot device: Network controller

Device Configurations e  Swap the functions of the fn key and left ctrl key.

e Enable/disable USB legacy support. When enabled, USB
legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

° Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a
USB port to the computer.
e Enable/disable BIOS DMA data transfers.

e Enable/disable fan always on while connected to an AC
outlet.

e Enable/disable data execution prevention.
e Enable/disable LAN power saving mode.
e Enable/disable SATA Native Mode.

e Enable/disable Dual Core CPU.

e Enable/disable HDD translation mode.
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Select

To do this

Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Dimensions

Depth 21.2cm (8.3 in)
Width 29.0 cm (11.4in)
Height (front to rear) 2.43 mm (0.96 in)
Weight

e  With 4-cell battery, no WWAN, no Bluetooth, no modem and one memory < 2.50 kg (3.3 Ibs)
module

NOTE: Weight varies by configuration and components.

Input power

Operating voltage 185Vdc@4.74 A—90 W
Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C (32°F to 95°F)
Operating (writing to optical disc) 5°C to 35°C (41°F to 95°F)
Nonoperating -20°C to 60°C (-4°F to 140°F)

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m (-50 ft to 10,000 ft)
Nonoperating -15 m to 12,192 m (-50 ft to 40,000 ft)
Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine
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Random vibration

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/
min sweep rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/
min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic
surfaces. The computer operates well within this range of temperatures.

30.7-cm (12.1-in) WXGA AntiGlare display specifications

Dimensions

Height 16.3cm (6.4 in)
Width 26.1 cm (10.3in)
Diagonal 30.7 cm (12.1in)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.204 x 0.204 mm
Format SD: 1280x800
Configuration RGB vertical stripe
Backlight LED

Character display 80 x 25

Total power consumption 4.0W

Viewing angle

+30° horizontal, +10° vertical (minimum)
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30.7-cm (12.1-in) WXGA BrightView display specifications

Dimensions

Height 16.3 cm (6.4 in)
Width 26.1 cm (10.3 in)
Diagonal 30.7 cm (12.1 in)

Number of colors

Up to 16.8 million

Contrast ratio

300:1 (typical)

Brightness

200 nits (typical)

Pixel resolution

Pitch 0.204 x .204 mm
Format HD 1280x800
Configuration RGB vertical stripe
Backlight LED

Character display 80 x 25

Total power consumption 40W

Viewing angle

+30° horizontal, £10° vertical (minimum)
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Hard drive specifications

500-GB* 320-GB* 250-GB* 80-GB SSD*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 115¢g 115¢g 115¢g 86 g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including
setting)
Single track 20ms 20ms 2.0ms
Average 12.0 ms 12.0 ms 12.0 ms
Maximum 22.0ms 22.0ms 22.0ms
Logical blocks 976,773,168 625,142,448 488,397,168 156,301,488
Disc rotational speed 7200 rpm 7200 rpm 7200 rpm
Operating temperature 0°C to 60°C (32°F 0°Cto60°C (32°Fto 0°Cto60°C (32°Fto 0°C to 70°C (32°F to
to 140°F) 140°F) 140°F) 158°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 7 backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot)
the computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
e  Store personal files in the Documents library, and back it up regularly.

e Back up templates that are stored in their associated programs.
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Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on
the type of external optical drive attached to your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

When backing up to discs, number each disc before inserting it into the external optical drive
attached to your computer.

To create a backup using Backup and Restore, follow these steps:

Bf NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.

2,

Select Start > All Programs > Maintenance > Backup and Restore.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.
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B NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD
to reboot the computer and repair the operating system. For additional information, refer to the “Using
a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

Bf NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Windows Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.
2. If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and then
click Disk Management.

Bf NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

EBf NOTE: Foradditionalinformation on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.
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B NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to recover
your operating system and software. To check for the presence of a recovery partition, select Start >
Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives section of
the window.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

B NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. Ifthe HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD, go
to http://www.hp.com/support, select your country or region, and then follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the Worldwide
Telephone Numbers booklet included with the computer.

/A CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

B NOTE: This process takes several minutes. Before rebooting, make sure you have changed the legacy
boot order in the F10 utility so that the USB CD-ROM drive is the first choice.

1. If possible, back up all personal files.

2. Restartthe computer, and then insert the Windows 7 operating system DVD into the external optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.
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Follow the on-screen instructions.
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Windows Vista backup and recovery

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only), or
create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

The Backup and Restore Center provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e  Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot)
the computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:
1. Display the screen you want to save.
2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.
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3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.
4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on
the type of external optical drive connected to your computer.

B NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the external optical drive.

To create a backup using Backup and Restore Center, follow these steps:

Bf NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

B NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

Bf NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Vista operating system DVD to reboot
the computer and repair the operating system. For additional information, refer to the “Using a Vista
operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.
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B NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. Ifpossible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

Bf NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows Vista operating system DVD and the
Driver Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

Bf NOTE: Foradditionalinformation on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11 recovery tools

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The 11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled. Personal files must be restored from a backup.

Ef NOTE: If your computer includes a solid-state drive (SSD), you may not have a recovery partition.
Recovery discs have been included for computers that do not have a partition. Use these discs to recover
your operating system and software. To check for the presence of a recovery partition, select Start >
Computer. If the partition is present, an HP Recovery drive is listed in the Hard Disk Drives section of
the window.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

Bf NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turnon orrestart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
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4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

/A CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

B NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.
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Follow the on-screen instructions.
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Windows XP backup and recovery

To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

e  Backing up individual files and folders
e  Backing up all files and folders

e Scheduling automatic backups

e Creating recovery points

e Recovering information

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

e Store personal files in the My Documents folder, and back it up periodically.

e Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.
c. Open a word-processing document, click Edit > Paste.
The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

149,

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

116 Chapter 7 Backup and recovery



NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

e  Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1. If possible, back up all personal files.
2. Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.
3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs

/A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system as well as software and drivers. Software, drivers, and updates
not installed by HP must be manually reinstalled. Personal files must be restored from a backup.

To recover your operating system and programs, follow these steps:
1. If possible, back up all personal files.

Insert the Operating System disc into the optical drive.

Shut down the computer.

2

3

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.
6

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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Linux backup and recovery
Use the instructions in this section if SUSE Linux SLED 11 is installed on your computer.

To protect your information, back up your files and folders. Then if the system fails, you can restore your
important files from copies. You can also use the options listed in this section to restore the operating
system and programs that were installed at the factory.

/A CAUTION: Usingf11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the original operating system and HP programs and drivers that were installed at the
factory. Software, drivers, and updates not installed by HP must be manually reinstalled. Personal files
must be restored from a backup.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. Restart the computer, and then press 11 while the “Press <F11> for recovery” message is
displayed on the screen.

3. Follow the on-screen instructions.
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8 Connector pin assignments

Audio-in (microphone)

==

Signal

Audio signal in

Audio signal in

Ground
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Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground
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External monitor

®OO00®
®000 W
©000G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

1917151311 &9 7 5 3 1

NrATATATAVATATATATAS

1816 1412 10 8 & 4 2

Pin Signal

1 Transition minimized differential signal (TMDS) data 2+
2 TMDS data 2 shield

3 TMDS data 2—

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0—

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 Consumer electronic control (CEC)
14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect
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RJ-11 (modem)

123456

Pin

Signal

Unused

Tip

Ring

Unused

o ||~ W |N| =

Unused

Unused
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RJ-45 (network)

Pin Signal

1 Transmit +
2 Transmit -
3 Receive +
4 Unused

5 Unused

6 Receive -
7 Unused

8 Unused
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Universal Serial Bus

1 2 3 4
I-_-_-_-.I

Pin Signal

1 +5 VDC (4.75 V minimum under a continuous 0.5-A load)
2 Data -

3 Data +

4 Ground
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eSATA/USB

Pin Signal

1 USB +5 VDC

2 USB Data -

3 USB Data +

4 USB Ground

S1 eSATA Ground

S2 eSATA Transmit Data A+
S3 eSATA Transmit Data A-
S4 eSATA Ground

S5 eSATA Receive Data B-
S6 eSATA Transmit Data B+
S7 eSATA Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States UL 2
1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance coupler

and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
When you remove these components, handle them carefully.

Bf NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

9 -

Bf NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).
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Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

Remove all screws (1) that secure the display panel assembly to the display enclosure.

Remove the display panel assembly (2) from the display enclosure.

!
i-

Turn the display panel assembly upside down.

Remove all screws that secure the display panel frame to the display panel.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

o

=3

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter
identifying 19
spare part numbers 29
antenna, disconnecting 44, 45
antennas 18
applications key, Windows 11
audio board
removal 68
spare part number
68
audio, product description 2
audio-in (microphone) jack 14
audio-in (microphone) jack, pin
assignments 119
audio-out (headphone) jack 14
audio-out (headphone) jack, pin
assignments 120

23, 30,

B
backing up
Linux 118
Windows 7 108
Windows Vista 112
Windows XP 116
backing up files 108
Backup and Restore
Backup and Restore Center
113
base enclosure, spare part
number 24
battery
identifying 19
removal 40
spare part number
battery bay 16
battery light, identifying 13
battery release latch,
identifying 16

108, 109
112,

24, 40

bays
battery 16
service access 16
BIOS administrator password 86,
94
BIOS reset 85, 93
Bluetooth module
removal 67
spare part number 23, 67
Bluetooth module cable 22, 27,
67
boot options 87, 95, 102
boot order 87, 95, 102
built-in device
ambient light sensor 89, 97
Bluetooth device radio 89, 97
embedded WLAN 89, 97
fingerprint reader 89, 97
integrated camera 89, 97
LAN/WLAN switching 89, 97
modem 89, 97
Network Interface Controller
(LAN) 89, 97
Notebook MultiBay 89, 97
Wake on LAN 89, 97
wireless hotkey 89, 97
WWAN device radio 89, 97
built-in device options 89, 97
button, power 10

C
Cable Kit

contents 27

spare part number 22, 27
cables, service considerations 34
caps lock light, identifying 9
chipset, product description 1
components

additional hardware 19

bottom 16

display 17

front 12

left-side 15

right-side 13

top 8
computer feet

locations 39

spare part number 39
Computer Setup

Diagnostic menu 101

File menu 85, 93, 100

navigating and selecting 83,

91, 99

restoring factory settings 84,

92, 100

Security menu 85, 94, 100

System Configuration

menu 86, 94, 102
computer setup 83, 91
computer specifications 104
connectors, service
considerations 34
cord, power 19
creating a backup 108

D
device configurations 87, 95
Diagnostic menu 101
discs

Driver Recovery 117

Operating System 117
Disk Sanitizer 86, 94
diskette drive, precautions 34
display assembly

removal 59

spare part numbers 22, 59
display back cover, spare part

numbers 26, 31, 59

display bezel

removal 61
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spare part number 61
spare part numbers 25
display cable, spare part
numbers 26, 31, 32, 59
display component recycling 129
display components 17
display hinge kit, spare part
number 26, 31, 59
display hinge, removal 63
display panel, removal 63
display specifications 105, 106
drive light 12
DriveLock password 86, 94
DriveLock, automatic 86, 94
Driver Recovery disc 117
drives
boot order 87, 95, 102
preventing damage 34
Dual Core CPU 88, 96
DVD£RW Double-Layer Drive with
LightScribe
precautions 34

E
electrostatic discharge 35
embedded numeric keypad keys,
identifying 11
error log 85, 93
eSATA port, pin
assignments 126
esc key, identifying 11
Ethernet, product description 2
Execution Disable 87, 95
external media cards, product
description 3
external monitor port
identifying 15
pin assignments 121

F
f11 recovery
fan
removal 75
spare part number
feet, locations 39
File menu 85, 93, 100
fingerprint reader,
identifying 10
fn key, identifying 11

110, 114

22, 75

136 Index

function keys
identifying 11

G

graphics, product description 1

grounding equipment and
methods 37

H
hard disk test 85, 93
hard drive
precautions 34
product description 2
removal 48
spare part numbers 23, 28,
48
specifications 107
hard drive connector cable,
illustrated 27
hard drive recovery
HDMI port
identifying 15
pin assignments 122
headphone (audio-out) jack, pin
assignments 120
heat sink
removal 75
spare part number
HP DayStarter 88, 96
HP QuickLook 88, 96
HP QuickWeb 88, 96
HP SpareKey enroliment

110, 114

22, 75

86, 94

|

internal display switch,
identifying 17

internal microphone,
identifying 17

J

jacks
audio-in (microphone) 14
audio-out (headphone) 14
RJ-11 (modem) 14, 123
RJ-45 (network) 15

K

keyboard

product description 3
removal 53

spare part number 22, 53

keys
esc 11
fn 11
function 11
keypad 11
Windows applications 11
Windows logo 11

L
LAN Power Save 87, 95
language, changing in Computer
Setup 86, 94
latch, battery release 16
legacy support, USB 83, 87, 91,
95, 99, 102
lights

battery 13

caps lock 9

drive 12

network activity 15

network connection 15

power 9
QuickLook 9
QuickWeb 9
sound mute 9
TouchPad 8
webcam 17
wireless 9
M

mass storage devices, spare part
numbers 28
Media Card Reader,
identifying 13
memory module
product description 1
removal 47
spare part number 23
spare part numbers 47
microphone (audio-in) jack 14
microphone (audio-in) jack, pin
assignments 119
microphone, internal 17
model name 1
modem jack, pin
assignments 123
modem module
product description 2
removal 65
spare part numbers 22, 65



monitor port, pin
assignments 121

N

network activity light 15

network connection light 15

network jack, pin
assignments 124

Numlock state 88, 96

(0]

Operating System disc 117

operating system, product
description 4

optical drive, precautions 34

P
packing guidelines 36
panels, product description 1
passwords 85, 94, 100
pin assignments
audio-in jack 119
audio-out (headphone)
jack 120
eSATA port 126
external monitor port 121
HDMI 122
headphone (audio-out)
jack 120
microphone (audio-in)
jack 119
modem jack 123
monitor port 121
network jack 124
RJ-11 123
RJ-45 (network) jack 124
Universal Serial Bus (USB)

port 125
plastic parts 33
Plastics Kit

contents 26

spare part number 26
pointing devices, product
description 3
port options

1394 port 89, 97

eSATA port 89, 97

flash media reader 89, 97

Smart Card slot 89, 97

USB port 89, 97

ports
external monitor 15
HDMI 15
product description 3
USB 13

USB/eSATA 15
power button, identifying 10
power cable, illustrated 27
power connector cable 22
power connector, identifying 14
power cord

identifying 19

set requirements 127

spare part numbers 29
power light, identifying 9
power requirements, product

description 3
processor, product description 1
product description

audio 2

chipset 1

Ethernet 2

external media cards 3

graphics 1

hard drives 2

keyboard 3

memory module 1

modem module 2

operating system 4

panels 1

pointing devices 3

ports 3

power requirements 3

processors 1

product name 1

security 3

serviceability 6

visual 2

wireless 2
product name 1

Q
QuickLook light, identifying 9
QuickWeb light, identifying 9

R

recovery 109

recovery partition 110, 114
release latch, battery 16

removal/replacement
preliminaries 33
procedures 38
restore factory settings 84, 85,
92, 93
restore hard drive 110, 114
restore security defaults 90, 98
RJ-11 (modem) cable 22
RJ-11 (modem) jack
identifying 14
pin assignments 123
RJ-11 (modem) jack cable,
illustrated 27
RJ-45 (network) jack
identifying 15
pin assignments 124
RTC battery
removal 70
spare part number 22, 70
rubber feet, spare part
number 39
Rubber Kit, spare part number 29
run-in test 85, 93

S
SATA (Serial Advanced
Technology Attachment) devices
AHCI (Advanced Host Controller
Interface) 87, 95
IDE (Integrated Drive
Electronics) 87, 95
screw kit, spare part number 29
security cable slot, identifying 14
security defaults, restore 90, 98
security level 90, 98
Security menu
allow reset of HP ProtectTools
security keys 86, 94
always prompt for HP SpareKey
enrollment 86, 94
Anti Theft 86, 94
Automatic DriveLock 86, 94
change password 86, 94
Disk Sanitizer 86, 94
DriveLock 86, 94
fingerprint reader reset 86,
94
HP SpareKey 86, 94
HP SpareKey enroliment 86,
94

Index 137



password policy 86, 94
set up BIOS administrator
password 86, 94
System IDs 86, 94
user management 86, 94
security, product description 3
serial number label, location 20
service access bay 16
service access door release
latches 16
service access door,
illustrated 26
service access door, spare part
number 24
service considerations 33
Service tag 38
serviceability, product
description 6
setup utility
Diagnostic menu 101
File menu 85, 93, 100
navigating and selecting 83,
91, 99
restoring factory settings 84,
92, 100
Security menu 85, 94, 100
System Configuration
menu 86, 94, 102
SIM
removal 42
spare part number 42
slots
Media Card Reader 13
security cable 14
solid-state drive, spare part
number 28
sound mute light 9
speakers
identifying 12
removal 78
spare part number 24, 78

specifications
computer 104
display 105, 106

hard drive 107
start-up test 85, 93
static-shielding materials 37
stringent security 101
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switch cover

removal 51

spare part number 22, 51
switch, internal display 17
system board

removal 71

spare part numbers 23, 71
System Configuration menu 86,

94, 102

system date and time 85, 93
system diagnostic 85, 93
system fan 87, 95, 102
system IDs 86, 94
system information 85, 93, 100

T
thermal material, replacement 76
tools required 33
top cover

removal 56

spare part number
TouchPad

identifying 8

left control 8

right control 8
TouchPad cable

illustrated 27
TouchPad indicator, identifying 8
TouchPad off indicator,

identifying 9

transporting guidelines 36

22, 56

U
Unified Extensible Firmware
Interface (UEFI) mode 88, 96
USB legacy support 83, 87, 91,
95, 99, 102
USB port
pin assignments 125
USB ports, identifying 13
USB/eSATA port, identifying 15

Vv

vents, identifying 12, 15, 16
video, recording 17
Virtualization Technology 88, 96
visual, product description 2

W
webcam 17
webcam light, identifying 17

webcam module, spare part
number 26
Windows 7 operating system
DVD 111
Windows applications key,
identifying 11
Windows Backup utility 116, 117
Windows logo key, identifying 11
Windows recovery 117
Windows Vista operating system
DVD 115
wireless antenna,
disconnecting 44, 45
wireless antennas 18
wireless light, identifying 9
wireless, product description 2
WLAN antennas 26
WLAN module
removal 42
spare part numbers 23, 42
workstation guidelines 36
WWAN antennas 26
WWAN module
removal 45
spare part number 45
WWAN module, spare part
number 23
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